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Abstract

Homogeneous charge compression ignition (HCCI) combustion can produce higher

efficiencies and lower emissions when compared to tradition spark or compression

ignition engines. This study reports an experimental investigation into the effects

of valve timings on HCCI combustion conditions. Using a single cylinder engine

with state-of-the-art electromagnetic variable valve timing (EVVT) fully independent

valves, a series of tests are conducted with varying negative valve overlap (NVO). The

in-cylinder residual trapped by the NVO causes an advance in combustion timing, a

shortening of burn duration as well as increase in load and increase in brake specific

fuel consumption. Asymmetric valve timings are also investigated and show com-

plex behavior with high sensitivity of combustion timing in certain operating ranges.

Finally, these strategies are implemented as a set of feedback controllers including a

proportional-integral (PI) controller and a feedforward with integral action controller.

Both controllers have good tracking for step changes in combustion timing setpoint

with the feedforward controller providing a rise time of just four cycles.
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Chapter 1

Introduction

1.1 Motivation

Emissions standards worldwide are becoming more stringent. For example, Tier 3

automobile and light truck emissions standards propose to decrease tailpipe nitrous

oxides (NOx) and hydrocarbons by over 80% and particulate emissions by 70% from

2016 levels by 2025 [EPA, 2013]. Passenger vehicles in the United States are also

required to increase overall fuel economy by 60% from 2016 levels by 2025 [DOT,

NHTSA, 2012]. This requirement has led engine and automobile manufacturers

looking into fuel saving and emission reducing methods such as engine down-sizing

and turbocharging, off-cycle improvements such as idle stop-start, and transmission,

rolling resistance and aerodynamic improvements. Alternative methods include fully

electric or electric hybrid vehicles, fuel cell vehicles, compressed natural gas engines,

extreme lightweight vehicles (carbon fibre body and chassis) or homogeneous charge

compression ignition (HCCI) engines [Weissler, 2013].

Although the alternatives to the conventional internal combustion engine (ICE)

mentioned above are available, when the life-cycle is looked at, they are not yet

a viable option [EPA, 2012]. A gasoline ICE is also shown to be more sensitive

to engine efficiency and technology improvements, as well as less sensitive to mass
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increases [Atkins and Koch, 2003]. The HCCI combustion cycle can operate in both

gasoline spark ignition (SI) and Diesel compression ignition (CI) engines with little

to no modification. HCCI uses the existing fuel system and combustion chamber and

the engine can be switched between the conventional (SI or CI) operating mode and

HCCI [Widd et al., 2011]. For this reason, HCCI is an attractive option to improving

overall fuel economy and reducing tailpipe emissions.

Unlike SI and CI operating modes, HCCI does not have a direct ignition timing

control mechanism. The ignition timing in HCCI operation is dependent on the

chemical kinetic state of the in-cylinder mixture at intake valve closing (IVC). This

condition creates a need to control the mixture temperature and/or composition at

IVC.

1.2 Problem Statement

The objective of this study is to examine experimentally the effects of valve timing

strategies on HCCI engine operation using a state-of-the-art electromagnetic variable

valve timing (EVVT) system. The effects on HCCI operating region, combustion

timing and duration, load, efficiency and emissions are examined. Using these findings

several different control strategies for controlling combustion timing are developed.

1.3 Thesis Organization

This thesis is organized into six chapters. Chapter two begins with an introduction

of the basics concepts of HCCI combustion, EVVT valves, negative valve overlap and

valve timing strategies, combustion metrics used in this thesis and examines previous

work. Chapter three covers the experimental setup, experimental uncertainty and

the testing conditions and operating points used. Chapter four contains the results

and discussion of the tests using different valve strategies and their effects on HCCI
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combustion. Chapter five details combustion timing control work in HCCI, including

a PI controller and a feedforward/feedback controller. Finally, Chapter six presents

conclusions of this study.

1.4 Contributions

The major contributions of this study are:

• Mapping of the engine operating region and analysis of the effects of engine

inputs on engine operation.

• A detailed experimental error analysis for the engine setup in this study

• Documentation of procedures needed for this complex engine setup
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Chapter 2

Background

An overview of the fundamental topics discussed in this study are given in this chapter.

A short summary of previous research pertinent to this study is also given.

2.1 HCCI

HCCI is described as a four-stroke engine cycle where a homogeneous air/fuel mixture

is ignited by cylinder compression alone [Najt and Foster, 1983]. Where the SI cycle

uses a spark plug to initiate combustion, and the CI cycle uses the injection of fuel into

a compressed (hot) air mixture, HCCI does not have a direct control of combustion

timing. Figure 2.1 shows a comparison of the three different combustion cycles.

Drawbacks of HCCI operation include the difficulty of controlling ignition timing,

a limited and low range of loads, and difficulty in switching between HCCI and other

modes. There is research into the areas of load range extension [Weall et al., 2012] and

mode switching [Widd et al., 2011]. This study focuses on the control of combustion

timing.

The combustion timing in an HCCI engine depends predominately on the chemi-

cal kinetic state of the in-cylinder mixture at IVC. Other dependencies include heat

transfer to the cylinder walls, compression ratio and rate of compression due to en-

gine speed. The control of HCCI combustion timing therefore can be implemented
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Figure 2.1: Comparison of SI, CI and HCCI combustion.

through controlling the mixture temperature and/or composition at IVC. There are

several strategies for controlling the mixture temperature and composition. One is

the thermal management of intake air [Haraldsson et al., 2004], another is the use of

variable compression ratio [Haraldsson et al., 2002], and there are dual fuel strate-

gies for controlling fuel octane, therefore controlling mixture properties [Audet, 2008]

[Audet and Koch, 2009].

A strategy of significant interest, and the topic of this study, is the reinduction

of combustion products through internal exhaust gas recirculation (EGR). Unlike

external EGR, internal EGR is achieved through different valve timing strategies.

The re-induction of exhaust gases effects the dilution and temperature of the mixture

at IVC, allowing HCCI combustion timing to be controlled.

2.2 Electromagnetic Valves

To achieve independent, cycle-by-cycle combustion timing using variable valve tim-

ings, a more complex system than a conventional camshaft system is needed. Typical
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production valve timing control systems on conventional camshafts are cam-phasers

[Audet, 2008] [Audet and Koch, 2009]. This allows the intake and exhaust timings to

be shifted by about 40 crank angle degrees (CAD). The drawbacks are that both the

opening and closing timings are moved simultaneously, and the actuation is typically

too slow for cycle-by-cycle changes at higher engine speeds.

For cycle-by-cycle independent timing a crankshaft-independent system is needed,

such as electromagnetically or hydraulically actuated valves. There are several styles

available for independent valve actuation. [Agrell et al., 2003b] use a fully hydraulic

system. These systems are large, draw a lot of power and are expensive [Mashkournia,

2012]. They are suitable for research and development purposes but not for industrial

or consumer use.

This study is conducted with the use of electromagnetic valves. These valves offer

fully independent, cycle-by-cycle valve timing changes in a small and light-weight

package [Mashkournia, 2012]. Drawbacks include the need for complex controllers

for valve operation, which leads to reliability issues, as well as temperature and wear

sensitivity.

2.3 Negative Valve Overlap

There are different strategies used to re-induct exhaust gas. In a standard engine,

exhaust valve close (EVC) and intake valve open (IVO) timings are usually set at

approximately top dead centre (TDC) of the exhaust stroke. If both timings are

moved as a unit into the exhaust stroke, exhaust gas is deposited into the intake

and re-breathed into the cylinder during the intake stroke. In a similar fashion, if

the timings are moved as a unit into the intake stroke, exhaust is expelled into the

exhaust and then re-inducted into the cylinder before the intake valve is opened.

The techniques described above are considered “re-breathing” techniques, where
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exhaust is expelled from the cylinder then re-inducted back in before intake or with

the intake charge. Another method, and the method used in this study, is the re-

compression of the exhaust gases. This is accomplished using negative valve overlap

(NVO), where the exhaust valve is closed earlier than TDC, and the intake valve is

opened late, or after TDC. This action traps exhaust residual within the cylinder to

be re-compressed by the piston, and then expanded until the intake valve is opened

and fresh charge inducted. If EVC and IVO timings are symmetrically timed around

TDC, it is called symmetric NVO (SNVO), this mode is shown in Figure 2.2.

Figure 2.2: Valve opening schematic as a function of crank angle degrees (CAD) of
(a) conventional valve timing and (b) symmetric negative valve overlap (SNVO).

Another valve strategy experimentally explored in this study is asymmetric NVO.

In this study, the asymmetric NVO timings use a constant NVO duration (CAD

between EVC and IVO timings) while the timings are advanced or retarded about

TDC. The timings for asymmetric NVO, referred to in this study, are the location of

the centre of the NVO duration. For example, if a test with a constant NVO duration

of 60 CAD and EVC timing is 40 CAD before TDC, and IVO is set to 20 CAD after

TDC, the timing would be listed as 10 CAD before TDC. A visual representation of

asymmetric NVO is shown in Figure 2.3.
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Figure 2.3: Valve opening schematic as a function of crank angle degrees (CAD) of
(a) symmetric and (b) asymmetric negative valve overlap.

2.4 Control and Modelling Strategies

Typically the goal of a controller is either regulation (keeping an output at a constant

value) or tracking (making the output follow a desired value). To achieve this goal,

feedback from the output is required. A basic feedback controller is a proportional-

integral-derivative (PID) controller. A controller structure is shown in Figure 2.4

where the plant is the system that is to be controlled and the setpoint is the desired

value for the output.

Figure 2.4: Basic structure of a feedback PID controller.

The PID in Figure 2.4 contains the formula for calculating the plant input value.

For a PID controller the input is calculated from the output error, or e(t) = ySet− y.
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In continuous time, the PID is:

u(t) = KP e(t) +KI

∫ t

0

e(τ)dτ +KD
de(t)

dt
(2.1)

The three gains in the equations are then tuned (either manually by trial and error, or

by other methods) to produce an acceptable response [Franklin et al., 2010]. The error

is multiplied by a proportional gain (KP ), this value dictates the responsiveness of

the controller, with a low KP having low responsiveness to error. For many systems,

if KP is too large, the system can become unstable. Solely proportional controllers

can also suffer from steady state error. The integral of the error, taken over all

time, is multiplied by the integral gain (KI). This term is used to reject steady-state

errors. Although too large a KI often results in overshoot and oscillation. Finally,

derivative gain (KD) regulates the change in error over time and is typically used to

damp out oscillations in the system. The derivative action also responds to sensor

noise which makes implementation difficult. When derivative action is not used, the

controller is referred to as a PI controller. The PID can be discretized using Tustin’s

approximation to [Franklin et al., 2010]:

uk = uk−1 +KP ek +KI
Ts
2

(ek + ek−1) +KD (ek − ek−1) (2.2)

Where Ts is the sample time. For a PI controller, the discretized form is:

uk = uk−1 +KP ek +KI
Ts
2

(ek + ek−1) (2.3)

A model of the system being controlled (the plant) is required for model based con-

trol and for designing the controller offline using simulation. Two general approaches

are used to get the plant model. The first approach is system identification, or “black-

box modelling”, where the system order and parameters are unknown. An input, that



10

persistently excites the dynamics of interest, forces the plant through the input and

the output is measured. A model is then approximated from the intput/output data

using statistical methods [Ljung, 1999]. Another approach is physics-based modeling,

where the governing equations to the system are combined and sometimes approx-

imated to achieve an input-output model directly from the physics involved. It is

possible to combine the two approaches. For example when using system identifica-

tion, if the physical structure of the system is known, the physical parameters can be

estimated using experimental results.

To incorporate knowledge of the system being controlled and knowledge of con-

straints a more complex controller, Model Predictive Control (MPC), is used. In

MPC, the controller uses a model to propagate the system dynamics forward in time

for two time horizons: the first is the prediction horizon, where the model is used

to predict the system’s output up to the horizon; the second is the control horizon,

usually smaller than the prediction horizon, where the controller calculates a set of

control inputs and evaluates the response with the model. However, the controller

outputs the calculated input from the model into the plant for only the current cycle

and then repeats this process each sample time. These types of controllers are often

implemented in systems with state and input constraints but require a slow process

due to computational overhead. If the model is computationally simple enough it can

be implemented at faster sample rates such as in combustion engines [Camacho and

Bordons, 2004].

2.5 Combustion Metrics

The combustion metric that is used as controller feedback in this thesis is the crank

angle where 50% of the mixture mass fraction is burned, denoted CA50. Since CA50

incorporates both start of combustion (SOC) and the burn duration, it is considered
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a good indicator of combustion timing in the engine. [Agrell et al., 2003a] uses CA50

as a control input for the feedback controller developed. [Lundstrom, 2006] also uses

CA50 as a control and model input, stating that SOC is more difficult to accurately

measure. [Bengtsson et al., 2006] quotes CA50 as a reliable source of combustion

timing for the use of feedback for control purposes. SOC and crank angle of peak

pressure have also been used [Shaver et al., 2004].

CA50 is defined as the crank angle degree after top dead centre (aTDC) that 50%

of the air/fuel mixture is burned and is found by finding the CAD location where 50%

of the heat from the mixture has been released. Cylinder pressure must be measured

as a function of crank angle. To do this, first the heat release rate as a function of

CAD is determined as [Heywood, 1988]:

dQ(θ)

dθ
=

γ(i)

γ(i)− 1
P (i)

dV (i)

dθ
+

1

γ(i)− 1
V (i)

dP (i)

dθ
(2.4)

where P (i) and V (i) are the measured pressure and calculated volume traces, respec-

tively. This equation for the heat release rate calculates the heat released through

work only, and neglects heat transfer and other inefficiencies. The ratio of specific

heats is:

γ(θ) =
Cp(θ)

Cp(θ)−RU

(2.5)

where Cp(θ) is the constant pressure heat capacity at the in-cylinder temperature at

crank angle θ, and RU is the universal gas constant (8.314 kJ
kmol K

). The specific heat at

a constant volume is replaced using Mayer’s relation Cp −Cv = RU . The integration

of Equation (2.4) over all of the sampling points gives the total heat release QTotal,

whereas the integration up to a certain CAD gives the cumulative heat released,
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QNet(θ). To find the heat release percentages the formula is used:

HR% =
QNet(θ)

QTotal

· 100 (2.6)

The crank angle where HR% is equal to 50 is considered CA50. Burn duration is

defined as the difference between the crank angles where HR% is equal to 90 and 10.

One way to define SOC is when the third derivative of the pressure trace surpasses

a certain limit [Ghazimirsaied, 2012] [Ghazimirsaied and Koch, 2012]. These metrics

are shown in Figure 2.5.
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Figure 2.5: Combustion metrics displayed with a common pressure trace.

HCCI engine operation is limited by knock at the high load end and misfire at the

low load end [Atkins, 2004] [Ghazimirsaied, 2012] [Ghazimirsaied and Koch, 2012].

In this thesis, HCCI misfire is defined when the air/fuel mixture fails to auto-ignite

completely, resulting in a lower indicated mean effective pressure (IMEP). A covari-
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ance in IMEP larger than 5% is deemed to be the misfire limit [Audet, 2008] [Audet

and Koch, 2009] [Lupul, 2008] [Weall et al., 2012].

Engine knock in HCCI combustion must be distinguished from engine knock in

standard SI combustion. In SI, knock is defined as autoignition of the unburned

mixture ahead of the propogating flame [Heywood, 1988], which causes damaging

oscillating pressure waves inside the cylinder. In HCCI autoignition is standard in

each cycle, and knock is caused by inhomogeneity within the mixture, such as lambda

(ratio of actual air and stoichiometricly required air), residual fraction or temperature,

which causes variation in combustion autoignition, resulting in pressure oscillations

[Mashkournia et al., 2011]. Currently there is no universally accepted metric for knock

detection in HCCI, but [Atkins, 2004] outlines a few different metrics, including a

simple knock amplitude method, a pressure rise rate method, and a method using a

bandpass filter and root mean squares. In this study, the knock limit is determined

heuristically using the audible signal. The pressure rise rate of this audible signal

agrees with previous literature. [Atkins, 2004] quotes a value of 10 bar/CAD as a

knock limit, whereas Lupul [2008] uses a value as 7 bar/CAD. In this study, the dP
dθ

knock limits as a function of fuel rate and NVO are shown in Figure 2.6. They are in

a range from 5 to 10 bar/CAD, agreeing with the previous literature. The knocking

cases are listed in Table 2.1, and four lower fuelling rates along with the knocking

case for each point are plotted to show the reduction in the knock metric as less fuel

is injected.

2.6 Effects of Negative Valve Overlap on Engine Operation

A brief summary of research into the effects of different valve strategies on HCCI

operation is presented in this section.

The control of HCCI using internal EGR, and the potential elimination of high
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Figure 2.6: dP/dθ for knocking case and four lower levels of fuelling. Each fuel step
is listed in Table 2.1.

intake temperature pre-heating is investigated in [Law et al., 2001]. Exhaust retention

(NVO) and exhaust re-induction (re-breathing) are examined and both are found to

be similar and have better combustion stability than SI operation. This study a

pioneering study into controlling HCCI combustion timing using internal EGR.

The effects of NVO on HCCI combustion including speed-load maps and a com-

parison between SI and HCCI is described in [Allen and Law, 2002]. The study quotes

lower emissions (except hydrocarbons in extreme HCCI conditions) and better fuel

efficiency. The study confirms that HCCI is a viable option for part-load conditions,

but HCCI does not have a large load range when compared to SI.

NVO and modelling to find a required thermal threshold for autoignition of the

air/fuel mixture in HCCI is studied in [Chen et al., 2003]. Different levels of internal

EGR through NVO and its effects on engine metrics such as combustion timing,

exhaust temperature and exhaust emissions are examined.

[Caton et al., 2005] looks at re-induction (re-breathing) versus retention (NVO)
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strategies for controlling HCCI combustion. The main focus is on different styles of

reinduction control, such as valve timing, lift or duration control of the intake valve,

and how it effects combustion metrics. The study goes on to compare a re-induction

strategy with a NVO strategy and cites higher efficiency by approximately 5% with

re-induction, but also higher emissions.

The effects of NVO and internal EGR on HCCI combustion at three different valve

overlaps and at different speeds and loads is reported in [Shi et al., 2006]. The goal of

the study is to expand the high load region of HCCI combustion, where an advanced

SOC is undesirable. It is found that while internal EGR introduces positive effects

such as improved homogeneity and lower emissions, the heat introduced through

internal residual advances SOC too far and results in a lower load limit.

The effects of valve timing and pilot direct injection on the combustion metrics of

a single cylinder engine is experimentally examined in [Weall et al., 2012]. The main

focus is the extension to low loads of HCCI operation using different direct injection

fuelling techniques. An investigation into NVO duration’s effect is also performed.

2.7 HCCI Timing Control with Variable Valve Timing (VVT)

Previous work on HCCI timing control is briefly summarized in this section. The

main focus is control using variable valve trains, ie. NVO, but other control methods

such as dual fuels and fast thermal management are also discussed.

[Agrell et al., 2003a] shows the use of NVO can be used to control ignition timing

in HCCI engines. They use a fully variable valve train changing NVO or IVC timings

to control combustion timing. This demonstrates that the use of variable valve timing

can be used to affect the in-cylinder temperature by controlling residual gas amounts,

which in turn directly effects combustion timing. A PI controller similar to the one

presented in this study is also implemented.
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[Shaver et al., 2004] went further and develops a simple non-linear physics based

model for controller design which includes simplified models for the intake, compres-

sion, combustion, expansion and exhaust. The controller uses volume and pressure at

peak pressure as set points and the controller outputs a desired molar ratio of residual

gases and volume at IVC. These values are used in a valve timing map to obtain the

desired inputs into valve timings for NVO and IVC.

[Lundstrom, 2006] develops a black-box modeling controller. Using white noise

inputs on NVO and IVC at different operating points, six different Output Error

models are developed. Using these models, controllers are designed using both pole

placement and loop shaping and a switching method between controllers for different

operating points (similar to gain scheduling) is used.

Using system identification for models and the MATLAB MPC toolbox, [Bengts-

son et al., 2006] compares two different control actuators: IVC timing and dual fuel

control. The study concludes that the IVC controller can operate in a larger re-

gion with less constraints. An MPC controller is successfully implemented with both

actuators on a six cylinder engine.

A controller using loop shaping is developed in [Bögemann, 2009]. The control

actuator is re-breathing lift where the exhaust valve is re-opened during the intake

stroke to a controlled lift and constant timing. This is similar to NVO in that the

controlled actuator directly effects combustion residual gases in the cylinder at IVC.

Another model based control is used in [Widd, 2009]. Based on a detailed non-

linear physical modelling of the process, multiple linearized models are derived from

the non-linear one and implemented in a Linear Varying Parameter model using MPC.

The controller actuators chosen are intake temperature and IVC. Subsequently, [Widd

et al., 2011] uses EVC timing as an actuator to compare linear quadratic (LQ) control

and MPC controllers. The models required for the MPC control are physics based.

A simple physical model is used to design a controller to reduce combustion insta-
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bility using valve timing in [Jungkunz, 2013]. A combustion timing controller is also

designed using fuelling strategies such as pilot injection timing and main injection

timing as inputs.

2.8 Work in This Study

This study conducts a further investigation into the effects of valve timing on HCCI

combustion characteristics from those found in Section 2.6. An extensive array of

valve timings and loads, along with multiple strategies are investigated using a pro-

duction relevant EVVT system. The system allows instant cycle-by-cycle valve tim-

ing variation without the bulk and setup associated with similar performing systems.

This also allows the implementation of faster controllers. The ground work is laid

for controller development using this system, and several controllers are implemented

similar to those found in Section 2.7.
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Chapter 3

Experimental Setup

3.1 Engine Assembly

The single cylinder engine used in this thesis has the same lower block as described in

[Lupul, 2008], [Audet, 2008] and [Audet and Koch, 2009], and consists of a Ricardo

Hydra Mark III block, a Ricardo crankshaft, a custom Carillo connecting rod, a

custom Diamond piston, a custom Darton Industries Inc. wet sleeve cylinder and

research EVVT head fitted by [Mashkournia, 2012]. The cylinder jug can be adjusted

to change the compression ratio of the engine, and in these tests the compression ratio

is fixed at 13.9 to 1. The piston is custom made with large valve recesses to allow for

free running of the engine, as shown in Figure 3.1. The EVVT setup (discussed later

in Section 3.3) allows for fully independent and adjustable valve timings. A picture of

the engine assembly is shown in Figure 3.2. The specifications of the engine assembly

are found in Table 3.1. To reduce engine vibrations transmitted to the dynamometer,

a shaft with two flexible couplings is used.

The dynamometer used is an active type consisting of a 37 kW DC motor with a

Eurotherm Drive 590+ drive controller in speed control mode. An Interface Inc.

SSMA-A-J-200N load cell mounted on the dynamometer is used to measure the

torque. The dynamometer, supercharger, DC motor and air plenum are shown in
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Figure 3.1: 97mm diameter piston crown used with the EVVT valves.

Parameters Values

Bore × Stroke [mm] 97 × 88.9
Compression Ratio 13.9
Displacement [L] 0.653

Valves (used) 2
Intake Valve Diameter [mm] 36

Exhaust Valve Diameter [mm] 24
Intake Valve Diameter [mm] 36

Exhaust Valve Diameter [mm] 24
IVO [aTDC Combustion] -360 to -260
IVC [aTDC Combustion] -180
EVO [aTDC Combustion] 180
EVC [aTDC Combustion] 260 to 360

Table 3.1: Specifications of the single cylinder EVVT engine assembly.
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Figure 3.2: Photograph of the engine block assembly.
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Figure 3.3.

The complete engine test setup, including the measurement outputs and control

inputs is schematically depicted in Figure 3.4. Air enters the system through a laminar

flow meter and then enters a large air plenum. It then passes through the electronically

controlled throttle. It passes through a roots-type supercharger (Eaton Automotive

MP45) which is driven by a variable speed electric drive that allows computer control

of boost. In this study no supercharger boost is used. The air then goes through

an intake air heater and is heated to 80 ◦C. Two independent port fuel injectors

provide the fuel. One fuel injector injects n-heptane fuel and one iso-octane. This is

what allows cycle-by-cycle octane level control. Fuel flow rate is measured only on

the n-heptane side using a coriolis meter (Pierburg PLU4000), which a pulse width

calibration is used for n-heptane (calibration on a flow bench with an R2 value of 0.99

[Audet, 2008] [Audet and Koch, 2009]). On the exhaust side, the external EGR loop

is controlled by an EGR valve which always remained closed in this study. There is

also the emissions bench sample extraction and five gas (hydrocarbons, O2, CO, CO2

and NOx) analyzers.

3.2 dSpace MicroAutobox

A dSpace microautobox is used for the engine controller. It consists of a dSpace model

ds1401 computer connected to custom power electronics. The controller is designed

with MATLAB Simulink R© and is used to set the valve timing, fuelling amount of

each injector (and thus octane), and spark timing (not used here). The computer

runs these tasks at a rate of 1000Hz, and calculates the next cycles fuel injector pulse

widths during the current cycle’s intake stroke. The MicroAutobox receives a crank

angle position signal from a hall sensor and a 36-1 toothed wheel on the crank shaft.

As this engine has electromagnetic valves there is no camshaft. To define combustion
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Figure 3.3: Photograph of the engine dynamometer, air plenum and supercharger
drive.
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Figure 3.5: Photograph of the cam encoder gear setup.

TDC for the dSpace engine control a cam signal is generated using a 2:1 gear reduction

and a hall sensor as shown in Figure 3.5. The dSpace system also receives sensor data

and combustion metrics from both Adapt and CAS (Section 3.4) at a rate of 100Hz

to help with controller design and actuation. All data from this system is logged on

a per-cycle basis. A screenshot of the dSpace control desk user interface for engine

control is shown in Figure 3.6, and the system computer can be seen on the left of

Figure 3.7.

The Microautobox is the system used for feedback control of combustion timing

in this study. A CA50 signal is fed from the CAS system (see Section 3.4) into

the Microautobox via an A/D converter. The Microautobox then sets valve timing

according to the controller and feeds those as triggers to the ds1103 valve controllers

(see Section 3.3).
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Figure 3.6: Snapshot of dSpace engine controller, RBS input model shown.

Figure 3.7: Photograph of the dSpace MicroAutobox and Baseline CAS systems.
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3.3 Electromagnetic Valves

A proprietary electromagnetic system developed by Daimler AG [Stolk and Gaisberg,

2001] is used for the intake and exhaust valves. They are of the hinged actuator

type shown in Figure 3.8, where a hinged armature is moved by opener and closer

electromagnetic coils and springs are present which are configured so the rest position

of the valve (open and closer electromagnets off) is in the middle position [Chladny

et al., 2005] [Chladny and Koch, 2008] [Seethaler et al., 2013]. The engine has a four

valve head and each of the 2 Daimler actuators assemblies consists of 2 valves. Since

the HCCI tests in this study are at low engine speed, only one intake and one exhaust

valve are active while the other two are held closed. This two valve setup is shown to

have better performance at load speeds and load, as shown in [Weall et al., 2012]. The

motion control and soft landing of the two valves are each controlled by two separate

dSpace ds1103 processors as described in [Mashkournia, 2012] with the valve motion

control in [Chladny, 2003] [Chladny et al., 2005] [Chladny and Koch, 2008] [Seethaler

et al., 2013]. The valve controllers recieve opening and closing trigger timings from

the dSpace microautobox engine controller.

The opening and closing timing of each EVVT valve is set independently on a

cycle-to-cycle basis. This allows for cycle-to-cycle control based on measured com-

bustion metrics using valve timing. The exhaust valve user interface is shown in the

screenshot in Figures 3.9. The ds1103 controllers, valve power electronics and power

supplies can be seen in Figure 3.10

3.4 Data Acquisition and Sensors

The A&D Technologies Adapt system is used for controlling the dynamometer and

collecting data from all the temperature and pressure sensors, at a sampling rate of

10Hz and is shown schematically in Figure 3.12. More details of this system are given
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Figure 3.8: Schematic of the valve opening mechanism [Stolk and Gaisberg, 2001].
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Figure 3.10: Photograph of the electromagnetic valve controllers, power electronics
and power supplies.
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in [Audet, 2008], [Audet and Koch, 2009] and [Lupul, 2008]. The Adapt system also

controls these inputs to the engine: throttle, intake temperature, intake pressure, oil

temperature, and coolant temperatures. The temperatures are measured with J and

K type thermocouples, while the pressures are measured by Valedyne P305D pressure

transducers. The oil and coolant temperatures are regulated by PI controllers using

liquid to water heat exchangers and electric heaters for their respective fluid loops.

The Adapt also communicates and collects data from the emissions bench which

measures five exhaust gases. A screenshot of the Adapt system user interface is

shown in Figure 3.11

Figure 3.11: A screenshot of the A&D Technologies Adapt user interface. Main screen
to control the engine and dynamometer is shown. Not shown is the emissions screen,
fuel measurement screen, digital I/O screen or temperature plots screen.

An emissions bench that consists of five gas analyzers that measure the amounts

of CO, CO2, O2, NOx and hydrocarbons in the sample gas stream and communicates

the results to the Adapt system via an D/A link. The stream can be switched between

the exhaust side or the intake side (to measure external EGR) of the engine. In this

study only the exhaust side is measured. The sample gas is pumped through a water
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trap to cool and condense any water vapour and then flows through the analyzers. A

schematic of the system is shown in Figure 3.13. The bench is shown in Figure 3.14.

To measure and record in-cylinder pressure, the A&D Baseline CAS system and an

in-cylinder pressure transducer are used. The pressure transducer is a water cooled

Kistler 6061B piezoelectric sensor mounted in the cylinder head. The transducer

is connected to a charge amplifier to amplify the signal before being sent to the

CAS system. At every engine cycle the sensor voltage is calibrated to the intake

runner pressure at intake valve closing timing. This sensor is water cooled to decrease

inaccuracy caused by thermal shock. The CAS system is triggered to measure based

on a crank angle signal. Here a BEI Industries model XH25D-SS-3600-T2-ABZC-

7272-SM18 with 3600 pulses per revolution encoder is used which results in cylinder

pressure being collected every 0.1◦ CAD, as shown in Figure 3.15. CAS can output

this data as well as many combustion metrics such as CA50, SOC and IMEP. CAS

data logs on an engine cycle (two engine rotations) based frequency, 7200 per cycle

for data such as the pressure trace and volume calculation, 720 per cycle for intake

manifold pressure, and 1 per cycle for everything else and the output metrics. The

Baseline CAS’s user interface is shown in the screenshot in Figure 3.16, and the

system itself is shown on the right side of Figure 3.7.

3.5 Experimental Uncertainty

A base steady state test under typical operation conditions is examined to determine

the sampling experimental uncertainty. The base test taken has an engine speed

of 817 RPM, a fuel octane of PRF0, a coolant temperature of 45 ◦C, a fuelling

rate of 0.4 kJ injected energy per cycle and symmetric negative valve overlap of 120

degrees, or operating point C from Table 3.6. The following data is collected: dSpace

microautobox for 101 engine cycles, CAS for 100 engine cycles, and Adapt for 150
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Figure 3.14: Photograph of the five emissions gas analyzers bench.
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Figure 3.15: Photograph of the BEI 3600 per revolution encoder and cam encoder.

Figure 3.16: A screenshot of the Baseline CAS user interface.
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samples over 15 seconds. To determine error in multiple sample tests the following

equation is used [Moffat, 1988]:

U0.95 = t0.025
1√
N

√√√√√ N∑
i=1

(
Xi − X̄

)2

N − 1
(3.1)

where U0.95 represents the 95th percentile experimental uncertainty, N is the number

of samples, Xi and X̄ are the sample and sample mean, respectively and t0.025 is the

one-tailed t-distribution value for degree of freedom ν. The degrees of freedom in

a experiment is N − 1 if N is the same for all experiments, or for multiple tests of

different N [Abernethy et al., 1985]:

ν =

(
K∑
i=1

S2
i

N

)2

K∑
i=1

S4
i

N2νi

(3.2)

where K is the number of error sources, Si is the variance in the current error source,

N is the total number of samples, and νi is the degrees of freedom in the current error

source. The last term in Equation (3.1) is call the root mean square, or RMS. The

error in the pressure trace is calculated at every 0.1 CAD. That is for every 0.1 CAD,

the 100 measured pressure cycles are averaged at each crank angle location (3600 per

revolution) and RMS is calculated (see Figure 3.17). The largest RMS of 1.3 bar is

used in the error calculation, located at 1.3 CAD aTDC for this test.

To determine the uncertainty when repeating a test at the same test conditions

(engine inputs held constant) but on a different day, five tests are taken at the same

nominal operating point on different dates. The nominal operating point is run at

the start and end of tests (these are labeled as pre-test or post-test in Table 3.2).

The mean values are taken from each test and an uncertainty analysis of the five is
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conducted. For cylinder pressure analysis, peak pressure is used. The resulting errors

are listed in Table 3.2 and are higher than sampling error, listed in Table 3.4.

For values calculated from data, error is found using [Moffat, 1988]:

(UR)0.95 = t0.025

√√√√ K∑
i=1

(
δR(X)

δXi

Si

)2

(3.3)

where (UR)0.95 is the 95th percentile uncertainty of the calculated value, K is the

number of error sources in the equation, R(X) is the equation to find the calculated

value, Xi is the current parameter source of error and Si is the variance in that

parameter. The error involved in inputs such as fuel mass and in-cylinder volume

are deemed small in comparison to larger errors such as cylinder pressure, and are

neglected.

The error involved in CA50 is more complex. CA50 is the CAD location of 50%

heat release. Since the resolution of the Baseline CAS system is only 0.1 CAD, the

exact location of 50% heat release is limited by this resolution. The location of the

first value over 50 is taken as CA50. So the error involved in this calculation is found

as:

δCA50 =
HR50% − 50

dHR%

dθ
|θ

(3.4)

Where δCA50 is the error in CA50, HR50% is the first heat release percentage value

over 50%, and dHR%

dθ
|θ is the derivative of the heat release percentage at the location

of CA50. This error is calculated for every test, and the largest error found is 3% and

is listed in Table 3.3. The calculation error propagated from the pressure error using

Equation (3.3) is also found, but is negligibly small compared to the truncation error.

When using Equation (3.3) on the IMEP calculation and neglecting the errors in
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cylinder volume, the resulting error equation is:

δIMEP =
d

dP

(∮
PdV

)
δP

Vd
(3.5)

Where δIMEP is the error in IMEP, δP is the error in cylinder pressure, and Vd is the

displaced volume of the engine. The solution to the derivative-integral combination

is found to be solely dV , the step size in in-cylinder volume due to sampling at 0.1

CAD.

When Equation (3.3) is applied to the rate of pressure change formula, it is found

that the resulting error equation is:

δ
dP

dθ
=

d

dθ
(δP ) (3.6)

Where δP is the error found for in-cylinder pressure. The error for the rate of change

of pressure is calculated for the full cycle, and the maximum is found to be 0.1

bar/CAD at 44.2 CAD aTDC of gas exchange. Note that the error found at 1.7 CAD

bTDC is 0.09 bar/CAD, and is the second largest found.

Value Uncertainty

Airflow [kg per cycle] 0.00001
BSFC [g/kWh] 4
CA50 [CAD] 0.1

Combustion Efficiency [-] 0.02
Dilution Ratio [-] 0.2
Heat Release [%] 3

IMEP [kPa] 0.2
Rate of Pressure Change [bar/CAD] 0.1

Residual Ratio [-] 0.1
Thermal Efficiency [-] 0.0005

Volumetric Efficiency [-] 0.02

Table 3.3: Experimental uncertainty in values calculated from data.

The uncertainties in the values used in this thesis are summarized in Table 3.4.
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Value Precision Reproducibility Bias Total Uncertainty

Airflow [L/min] 4 1 0.5 4
CA50 [CAD] 0.08 1 0.1* 1

CO [%] 0.00003 0.09 0.02 0.09
CO2 [%] 0.00008 0.3 0.05 0.3

Combustion Efficiency [-] - - 0.02* 0.02
Cylinder Pressure [bar] 0.3 2 0.5 2

Dilution Ratio [-] - - 0.2* 0.2
Engine Speed [RPM] 0.1 0.0003 2 2

IMEP [kPa] 0.01 0.1 0.2* 0.2
Lambda 0.004 0.1 0.04 0.1

NOx [ppm] 0.005 2 0.1 2
O2 [%] 0.00009 0.2 0.09 0.2

PIntake [kPa] 0.1 0.7 0.5 0.9
Residual Ratio [-] - - 0.1* 0.1

TExhaust [◦C] 0.05 10 2 10
TIntake [◦C] 0.01 0.1 2 2

Thermal Efficiency [-] - - 0.0005* 0.0005
Torque [Nm] 0.05 0.7 0.008 0.7

Hydrocarbons [ppm] 100 900 30 900
Volumetric Efficiency [-] - - 0.02* 0.02

*from calculation error

Table 3.4: Experimental uncertainty in measured values used in this study.
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3.6 Test Conditions

All test conditions are summarized in Table 3.5. Only the fuelling rate and NVO are

varied from these typical base condition in these experiments. There is one experiment

where the fuel is changed from PRF0 to PRF20 and this is described later. The

two operating points that will distinguish between the octane numbers are listed in

Table 3.6.

Variable Type Set Range

Engine Speed [RPM] Regulated 800 817 to 818
Throttle [%] Regulated 60 60

Coolant Temperature [◦C] Regulated 50 45 to 53
Intake Temperature [◦C] Regulated 80 74 to 83

Oil Temperature [◦C] Regulated 50 50
Exhaust Temperature [◦C] Measured - 103 to 213

Intake Pressure [kPa] Measured - 88 to 90
Oil Pressure [kPa] Measured - 372 to 384

Airflow Rate [L/min] Measured - 101 to 187
Lambda [-] Measured - 1.78 to 4.12
IMEP [bar] Measured - 0.03 to 2.68

Torque [Nm] Measured - 0 to 10.5
BSFC [g/kWh] Measured - 298 to 914

SOC [CAD aTDC] Measured - -9.4 to -7.3
Burn Duration [CAD] Measured - 2.7 to 10.9

Peak Pressure [bar] Measured - 26.5 to 52.2
Peak Pressure Location [CAD] Measured - -2.4 to 9.0

Maximum Heat Release Rate [J/CAD] Measured - 6.1 to 172.1
Combustion Efficiency [%] Measured - 10.1 to 78.6

Total Heat Release [J] Measured - 28.1 to 436.5
Fuelling Rate [kJ per cycle] Input 0.28 to 0.56 -

Octane Number [PRF] Input 0 to 20 -
IVO [aTDC Combustion] Input -360 to -260 -
IVC [aTDC Combustion] Input -180 -
EVO [aTDC Combustion] Input 180 -
EVC [aTDC Combustion] Input 260 to 360 -

CA50 [CAD aTDC] Output - -6.0 to 8.4

Table 3.5: Engine HCCI Operation Range
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Operating Point A B C

Fuelling Rate [kJ per cycle] 0.28-0.56 0.34-0.49 0.4
Octane Number [PRF] 0 20 0

NVO [CAD] 0-200 0-180 120

Table 3.6: Base Engine Test Conditions
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Chapter 4

Effects of NVO on HCCI Combustion

The effects of NVO on HCCI engine operation is experimentally tested and the results

are described here. The data collected have NVO variation from 0 CAD to 200 CAD

in 20 CAD steps and the fuel rate is varied between engine misfire and engine knock

limits. Misfire is defined as the point when the IMEP covariance for 100 engine cycles

surpasses 5%, and the knock limit is detected audibly. Once the data are collected

and sorted, the contours for plotting are produced by cubic spline interpolation onto

a regular interval. Due to the nature of cubic spline interpolation, some of the abnor-

malities near the edges of the contour maps do not reflect the actual behavior in the

data. All the NVO test results as a function of lambda are shown in Figure 4.1 and

as a function of fuelling rate in Figure 4.2. Two primary reference fuels (PRFs) are

shown, n-Heptane (PRF0) and 20 octane (PRF20), and tests show that the higher

octane fuel results in a smaller fuelling rate operating region of the engine.

4.1 Effects of EGR on HCCI Combustion

NVO duration predominately changes the amount of residual exhaust gases remaining

in the cylinder. There are four main effects of EGR on HCCI combustion [Atkins,

2004]. The most influential effect is the residual heat used to heat the intake charge

and modify charge temperature. The EGR also offers dilution effects much like a
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lean air/fuel mixture, but with higher sensitivity in influencing combustion timing

and duration [Atkins, 2004]. EGR also changes the mixtures thermal properties,

such as specific heat. Finally, EGR introduces chemical species which can change the

combustion of the air/fuel mixture due to the chemical kinetic state being changed.

4.2 Engine Operating Region for varying SNVO

To generate the experimental results, SNVO is held at a constant value near engine

misfire conditions then the fuelling rate to the fuel injector is increased in steps

from misfire to knock. At each fuelling rate the engine is run at steady state and

data collected. Then SNVO is varied between 0 CAD and 200 CAD in 20 CAD

increments and the fuelling rate is again varied. This is done for two fuels. The

effect of varying SNVO on steady state HCCI engine operation is examined as a

function of lambda, fuelling rate and IMEP in Figures 4.3, 4.4, and 4.5 respectively.

A typical engine operating region metric is lambda [Atkins, 2004]. Figures 4.3a with

PRF0 and 4.3b with PRF20 provide a basis for comparison. Comparing Figures 4.3a

and 4.3b, the operating region narrows and changes location as the octance number

(PRF) increases. This is a result of the higher auto-ignition tendencies found in lower

octane fuels. The four effects of dilution on combustion increase as the PRF increases,

therefore reducing the operating region [Atkins, 2004]. Both Figures 4.6a and 4.6b

show that generally CA50 advances as SNVO increases for a constant lambda. A

trend of decreasing lambda with increasing SNVO is shown in Figures 4.3 which

agrees with the results in [Weall et al., 2012]. Below approximately 80 CAD of SNVO,

lambda remains fairly constant, while above 80 CAD of SNVO, lambda decreases in a

linear-like fashion. Above 80 CAD of SNVO large amounts of internal EGR decreases

the amount of fresh intake air in the cylinder every cycle which decreases lambda.

Since lambda is not a direct input in this experiment, and is correlated with SNVO,
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Figure 4.3 is not an accurate representation of the engine operating region.

The engine operating range and CA50 timing contours for constant fuelling rates

are shown in Figure 4.4. As fuelling rate is one of the inputs (with SNVO), Figure 4.4

directly shows the engine operating range for the two fuels. The higher PRF fuel has a

smaller operating region, as shown earlier. The combustion timing, CA50, gradually

advances as SNVO increases for a constant fuelling rate.

The operating range in terms of engine load (IMEP), with combustion timing

(CA50) contours are shown in Figures 4.5. At constant IMEP, as SNVO is increased,

CA50 initially retards and then advances. This can be attributed to the dual regions

discussed in Section 4.4. At high values of SNVO, above approximately 120 CAD, the

IMEP range decreases. This is attributed to the increasing internal residual, making

the charge more sensitive to knock (high heat in the residual) or misfire (less fresh

intake with fuel).

Since the HCCI operating point of this engine is very lean and the SNVO allows

residual to remain in the cylinder, the dilution of the gas mixture is a combination of

excess fresh air and residual gas. A ratio is formed in [Atkins, 2004] to calculate the

amount of dilution for a given operating point, and is given as:

rDilution =
mExcess air +mResidual

mStoich

(4.1)

where mExcess air is calculated using the laminar airflow meter, while mResidual is

calculated using:

mResidual = (
1

ηV
− 1)mAir, ∀ηV ≤ 1 (4.2)

Where ηV is the volumetric efficiency from the intake runner [Heywood, 1988]:

ηV =
mAir

ρAirVd
(4.3)
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Where ρAir is the density of air in the intake runner. The results of Equation (4.1) can

be found in Figure 4.7. The dilution ratio is effected by fuelling rate as the fuelling

rate directly changes the denominator of Equation (4.1). The SNVO duration does

not have much of an effect on the dilution of the cylinder due to the diluent being

changed from air to residual, and no effective change in the amount of diluent.

To see the increase in internal residual within the intake charge, the second part

of Equation (4.1) is plotted similar to Figure 4.8. The result is shown in Figure 4.8,

and shows an inversed trend to the airflow shown later in Figure 4.26. This result is

expected and shows the increase in internal residual as SNVO is increased.

4.3 Effects of SNVO on CA50

One main goal of using SNVO is to control HCCI combustion timing. In this work,

CA50 is used as the measure of combustion timing and with SNVO is plotted to

show contours of constant fuelling rate (Figure 4.9). Controlling combustion timing is

essential for HCCI combustion [Agrell et al., 2003b] [Shaver et al., 2004] [Agrell, 2006]

[Lundstrom, 2006] [Shi et al., 2006] [Bengtsson et al., 2006] [Bögemann, 2009] [Widd,

2009] [Widd et al., 2011] [Bidarvatan et al., 2014]. The contours of constant fuelling

rate show how the combustion timing (CA50) changes when fuelling remains constant

and SNVO is varied. Generally the combustion timing shows a steady advance as

SNVO increases, although there is a slight hump at 120 CAD of SNVO, and an upward

inflection in the higher regions. This agrees with similar studies, such as Figure 11

from [Weall et al., 2012], where retarding of CA50 timing is seen with decreasing

SNVO. [Chen et al., 2003], [Caton et al., 2005] and [Shi et al., 2006] also find the

same results. This result is attributed to increased amounts of hot trapped residual

gases at higher levels of SNVO, this heat causes an earlier combustion event given

that the fuel quantity is constant.
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Figure 4.8: Engine operating region showing residual ratio for SNVO versus fuelling
rate for PRF and PRF20.
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Figure 4.9: Effects of SNVO versus CA50 with respect to fuelling rate for PRF0 and
PRF20.
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Contours of constant load (IMEP) as a function of combustion timing (CA50) and

SNVO are shown in Figures 4.10. This illustrates what happens to CA50 if SNVO

is changed and a constant load is maintained. CA50 advances as SNVO duration is

increased and IMEP is held at a constant, although there is a slight upwards inflection

(retarding of combustion timing) near the higher duration regions of SNVO duration.

The effect of SNVO on burn duration is shown in Figure 4.11. Burn duration

shows similar behavior to that of CA50, in particular the duration begins to lengthen

as CA50 retards past TDC. This effect is attributed to the dilution effects of the

trapped residual [Atkins, 2004] as well as the advance of the timing event into a

region where the piston is travelling down the cylinder at a higher rate.

Figures 4.12, 4.13 and 4.14 show a comparison of both fuel octanes at a single

fuelling rate. Both fuels show a similar trend, yet PRF20 shows a more retarded,

longer duration burn at a higher load. The retarding of the timing is caused by

less auto-ignition tendency in the PRF20 fuel, causing a later ignition timing. The

burn duration increases due to the combustion timing being after TDC, in a region

where burn duration is elongated and results in a higher IMEP as the combustion

occurs during the downstroke of the piston. For CA50 before TDC, particularly

with the PRF0 fuel, a sharp decline in burn duration is witnessed as well, as the

rapid compression of the combusting mixture during the upstroke shortens the burn

duration.

4.4 Effects of SNVO on Engine Load

To examine the differences in fuelling and load a contour map of IMEP with SNVO

on the x-axis and fuelling rate on the y-axis for two fuels is shown in Figure 4.15.

At a constant fuelling rate, as SNVO is increased, the load slightly increases. This

is attributed to the decrease in lambda seen in Figure 4.3 as well as a shift in peak
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Figure 4.10: Effects of SNVO versus CA50 with respect to IMEP for PRF0 and
PRF20.
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Figure 4.11: Effects of SNVO versus fuelling rate with respect to burn duration for
PRF0 and PRF20.
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Figure 4.12: A comparison of CA50 for an injected fuel energy of 0.42 kJ per cycle
for PRF0 and PRF20 with respect to SNVO.
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Figure 4.13: A comparison of burn duration for an injected fuel energy of 0.42 kJ per
cycle for PRF0 and PRF20 with respect to SNVO.
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Figure 4.14: A comparison of IMEP for an injected fuel energy of 0.42 kJ per cycle
for PRF0 and PRF20 with respect to SNVO.

pressure timing causing a load change. Also the dilution effects of the residual de-

creases heat transfer to the cylinder walls which results in an increase in IMEP.

In [Chen et al., 2003], they find the opposite effect. This could be attributed to a

number of factors, although lambda would be one of the prominent causes to a drop

in IMEP as EGR rates increase.

Combustion timing (CA50) as a function of engine load (IMEP) is plotted for each

of the eleven constant values of SNVO in Figures 4.16. There seems to be two SNVO

ranges to these curves: (1) between SNVO of 0 to 100 CAD, the curves have a smaller

slope of approximately −3 CAD/bar up to approximately 1.9 bar IMEP; (2) when

SNVO is greater than 100 CAD the combustion timing advances rapidly with load

with a slope of approximately −8 CAD/bar. This combustion timing effect is also

partially seen in Figure 6 of [Shi et al., 2006], where a slight downward inflection of

the timing/load curves is seen. In the lower range, SNVO advances timing and lowers

load as it increases, [Shi et al., 2006] finds a similar result. The other SNVO range

(SNVO’s between 120 and 200) has a more linear result, but does not reach as low a
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Figure 4.15: Effects of SNVO versus fuelling rate with respect to IMEP for PRF0
and PRF20.
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load as the lower SNVO range. At mid-region loads (below the inflection seen in the

low SNVO range), the high SNVO range has a higher CA50, and does not show much

correlation between SNVO and load or timing. In the higher load regions (above the

inflection mentioned earlier), these curves resume the normal behavior of the other

curves, including the correlation between increased SNVO and lowered timing and

load. Burn duration is shown in Figures 4.17, and the curves show similar behavior

as the CA50 curves in Figures 4.16. Figure 4.18 shows a comparison of CA50 and

burn duration.

4.5 Effects on Thermal Efficiency

Brake specific fuel consumption (BSFC) is shown in Figures 4.19 with respect to in-

jected fuel energy. Again the dual range of SNVO is seen. The lower range (SNVO

durations from 0 to 100 CAD) achieves a lower overall BSFC, but in the low fuel

injected energy region the higher SNVO range tends to achieve a lower BSFC. Fig-

ure 4.15 also shows that the upper range of SNVO durations produces a slightly larger

load (for the same injected fuel energy), so if Figure 4.19 is plotted against IMEP

instead of fuelling rate, a more regular trend of increasing BSFC with SNVO duration

can be seen (see Figure 4.20). The studies [Abd-Alla, 2002] and [Agarwal et al., 2011]

both look at the effect of external EGR on BSFC in a diesel engine, and both found

opposite effects. [Abd-Alla, 2002] showed that an increase in external EGR lead to a

decrease in BSFC. [Agarwal et al., 2011] showed that BSFC slightly decreased with

increased external EGR. This suggests that engine layout and operating parameters

have large effects on BSFC as well. This might be why [Chen et al., 2003] and [Weall

et al., 2012] both showed the opposite effect of NVO on BSFC.

Figures 4.21, 4.22, and 4.23 show the optimal operating point with respect to

thermal efficiency (kinetic energy extracted per injected fuel energy). The equation
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Figure 4.16: Plot of IMEP versus CA50 with lines of constant SNVO for PRF0 and
PRF20.
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Figure 4.17: Plot of IMEP versus burn duration with lines of constant SNVO for
PRF0 and PRF20.
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Figure 4.18: Plot of CA50 versus burn duration with lines of constant SNVO for
PRF0 and PRF20.
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Figure 4.19: Plot of fuelling rate versus BSFC with lines of constant SNVO for PRF0
and PRF20.
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Figure 4.20: Plot of IMEP versus BSFC with lines of constant SNVO for PRF0 and
PRF20.
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used to calculate ηThermal is:

ηThermal =
VdIMEP

EInjected
=

VdIMEP

LHVmFuel

(4.4)

where EInjected is the amount of fuel injected per cycle in kJ, calculated by the product

of injected fuel mass (mFuel) and the fuels lower heating value (LHV). The resulting

efficiencies are compared to CA50, burn duration and work efficiency are shown in

Figures 4.21, 4.22 and 4.23. Work efficiency is defined as:

ηWork =
QTotal

EInjected
(4.5)

Where QTotal is the heat release calculated from the pressure trace in Equation (2.4).

The optimal efficiency found was 36% for PRF0 fuel at an SNVO duration of 140

CAD and a CA50 timing of -2.6 CAD aTDC with a burn duration of 4.8 CAD.

The combustion efficiency was found to be 69% at that point. For PRF20 fuel, the

most efficient point was 37% at an SNVO duration of 40 CAD, a CA50 timing of

0.6 CAD aTDC with a duration of 4.3 CAD, and a combustion efficiency of 72%.

For the PRF20 fuel, the most efficient point is also around the highest load point,

but for PRF0 fuel, the load continues to increase as timing is advanced further and,

more significantly, as SNVO duration is increased. It is also seen that as combustion

efficiency increases past the thermal efficiency peak for both fuels, into the higher

load region for PRF0, the thermal efficiency begins to decrease.

Figures 4.21 through 4.23 show higher durations of SNVO result in higher thermal

efficiency while Figure 4.20 suggests the opposite. This conflict can be attributed to

the fact that ηThermal is calculated from in-cylinder pressures, while BSFC is calculated

using dynamometer torque measurements. This loss in efficiency is due to the heat

and pumping losses during the recompression stage of the SNVO, which increases
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Figure 4.21: Thermal efficiency compared to CA50 with lines of constant SNVO for
PRF0 and PRF20.
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Figure 4.22: Thermal efficiency compared to burn duration with lines of constant
SNVO for PRF0 and PRF20.
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Figure 4.23: Thermal efficiency compared to combustion efficiency with lines of con-
stant SNVO for PRF0 and PRF20.
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with increasing SNVO.

To see the effects of timing on thermal efficiency and BSFC, a P-V diagram for

two fuelling rates at 80 CAD of SNVO duration is plotted in Figure 4.24. This figure

shows the P-V diagram for a low thermal efficiency point, corresponding to a CA50

timing of 4 CAD aTDC, and a point of high thermal efficiency, corresponding to

a CA50 timing of -2 CAD aTDC. The work output for the higher efficiency plot

can be seen to be much larger due to the much higher peak pressure at TDC of the

compression stroke, whereas compression work for both plots remain similar. The low

peak pressure in the other plot is due to the late combustion resulting in a late peak

pressure timing, when the cylinder volume is larger, resulting in lower peak pressures.

The pumping losses for both points are relatively equal.
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Figure 4.24: Comparison of a High Thermal Efficiency (CA50 = -2 CAD aTDC) and
a Low Thermal Efficiency (CA50 = 4 CAD aTDC) points using a P-V Diagram

4.6 Effects of SNVO on Emissions

In this section the experimental results of SNVO effects on HCCI engine exhaust

emissions is described. The emissions are collected with a 5-gas analyzer which can
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only capture emissions at steady state operation, due to the large time constant

of the measurement system and samples lines. Measurements of CO2, CO and O2

in percentage, and NOx and hydrocarbons in ppm are collected with details of the

measurement errors in Table 3.4.

Since exhaust temperature control is of importance to maintain high efficiency

in the catalytic converter, it is also measured. A typical catalytic converter has a

light-off temperature of 600 K, the temperature at which the conversion of CO and

hydrocarbons exceeds 50% [Heywood, 1988]. The low exhaust temperatures experi-

enced during HCCI combustion will require special catalysts. Experimental results

show that SNVO has a slight effect on exhaust temperature, as shown in Figures 4.25.

There is a slight rise in exhaust temperature as more SNVO is introduced, but only at

most 30 ◦C in change. [Caton et al., 2005] shows a similar slight increase in exhaust

temperature. The temperatures seen in the exhaust of the engine are extremely low,

which can be attributed to the low loads. Large combustion chamber crevices (see

Figure 3.1) are regions of low temperatures and often have incomplete combustion

which affects emissions significantly.

Figure 4.26 shows that the total airflow into the engine begins to reduce signifi-

cantly above 100 CAD of SNVO. This is reflected in the residual ratio described in

Figure 4.8. The effects of this can easily be seen in the lambda and fuelling rate

contours of Figures 4.3, where the lambda gets richer at constant fuelling rates as

SNVO increases past 100 CAD. This is the result of a short intake valve duration and

a large amount of residual held within the cylinder cycle to cycle.

The effect of SNVO on CO2 emissions is a linear increase in percentage of exhaust

gas sample, seen in Figure 4.27. This can be attributed, in conjunction with the

decrease in O2 shown in Figure 4.28, to an increase in the completeness of combustion

and results in a higher exhaust temperature (Figures 4.25). There is also a reduction

in hydrocarbons (despite an outlier) in Figure 4.29. This reinforces the findings
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Figure 4.25: Effects of SNVO versus fuelling rate on exhaust temperature for PRF0
and PRF20.
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Figure 4.26: Effects of SNVO versus fuelling rate on airflow rate for PRF0 and PRF20.
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of increased fuel efficiency in Section 4.4, as an increase in combustion efficiency

generally results in an increase of fuel efficiency (Figure 4.23). [Caton et al., 2005]

looks into hydrocarbon emissions as a result of SNVO, but does not clearly present

the results as a function of SNVO angle or amount of EGR.
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Figure 4.27: Effects of SNVO on CO2 emissions for five fuelling rates of PRF0.
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Figure 4.28: Effects of SNVO on O2 emissions for five fuelling rates of PRF0.

The hydrocarbons presented in Figure 4.29 are fairly high. This is attributed

to the large crevice volumes on the piston crown required for free-running EVVT
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operation, and low loads. There is also correlation with the low exhaust temperature,

which indicates a lower in-cylinder temperature during combustion, and poor or no

combustion in the crevices and near the walls [Christensen et al., 2001]. At low loads

and high dilution, the chemical reactions also do not go to completion, resulting in

higher hydrocarbon and CO emissions [Dec and Sjöberg, 2003].
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Figure 4.29: Effects of SNVO on hydrocarbon emissions for five fuelling rates of
PRF0.

The NOx emissions in Figure 4.31 are very low (near the resolution of the in-

strument) due to low combustion temperatures. The creation of NOx occurs due

to in-cylinder temperatures above 1800 C [Heywood, 1988]. In [Atkins, 2004], the

investigation of NOx versus in-cylinder peak pressure found that for increasing peak

pressure and increasing PRF, NOx increased. For the values of peak pressure and

PRF in this study, NOx will be nearly negligible. [Shi et al., 2006] found that NOx

increases with IMEP and NVO. [Caton et al., 2005] finds the same effect with increas-

ing mean effective pressure (MEP). Both studies have NOx measurment points much

higher than 20 ppm probably due to the higher loads. [Shi et al., 2006] has loads

between 3 and 4 bar IMEP and [Caton et al., 2005] between 2 and 3.5 bar IMEP.



79

0 50 100 150 200
0

0.2

0.4

0.6

0.8

1

1.2

1.4

1.6

Symmetric Negative Valve Overlap (CAD)

C
O

 E
m

is
si

on
s 

(%
)

 

 
0.3400 kJ Fuel
0.3610 kJ Fuel
0.3800 kJ Fuel
0.3900 kJ Fuel
0.4000 kJ Fuel

Figure 4.30: Effects of SNVO on CO emissions for five fuelling rates of PRF0.
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Figure 4.31: Effects of SNVO on NOx emissions for five fuelling rates of PRF0.
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Figure 4.32: Flowchart of the effects of SNVO and fuelling rate on engine operation.

This section, along with the previous sections, shows that using SNVO and fuelling

rates as inputs influence combustion timing, CA50 and burn duration, which in turn

affects the load, IMEP. This is a result of the two inputs, SNVO and fuelling rate,

affecting the internal exhaust residual and lambda of the in-cylinder mixture. The

residual and lambda dictate the temperature and total fuel energy in the cylinder,

influencing the duration and timing of the combustion. Figures 4.16 and 4.17 show

that if the burn duration is short and the timing is advanced, the resulting IMEP is

highest. The main effects of each value are shown in a flowchart in Figure 4.32.

4.7 Effects of Asymmetric NVO

Asymmetric NVO valve timing strategy is tested in this section. The timings shown

are where the symmetry of the valves fall with respect to TDC, as explained in

Section 2.3. Sets of tests are conducted at 40 CAD, 60 CAD and 80 CAD of NVO,

and the timing is varied until the EVVT valves failed due to abnormal pressures. All

the tests are run at 800 RPM and 0.4 kJ per cycle of PRF0 fuel.

Figures 4.33 through 4.35 show the early, late asymmetric and symmetric pressure

trace and net heat release curves. The late asymmetric timing shows the fastest rising

heat release curve and highest peak pressure, with the shortest burn duration and

earliest CA50 in Figure 4.3.

The effects of asymmetric NVO on the dilution ratio of the cylinder charge is

again calculated, and the result is no change between valve timings or durations.

The dilution ratio remained approximately constant at 3.2 for the cases tested. The
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Figure 4.33: Pressure traces and heat releases for three separate asymmetric timings
at 40 CAD of NVO.
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Figure 4.34: Pressure traces and heat releases for three separate asymmetric timings
at 60 CAD of NVO.
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Figure 4.35: Pressure traces and heat releases for three separate asymmetric timings
at 80 CAD of NVO.

residual ratio of the mixture is also more complicated for this valve strategy, and the

simplified formula used in Section 4.2 will not take into account all the fluid dynamics

occurring during the gas exchange process.

The timing effects of asymmetric NVO are shown in Figure 4.36. CA50 shows an

approximately flat slope when the valve timing is before -5 CAD aTDC. This is very

near the symmetric timings of 0 CAD aTDC. CA50 then begins to decrease for all

NVO durations after -5 CAD aTDC. Although the burn duration trend is harder to

discern, it can also be seen to be decreasing slightly after -5 CAD aTDC. This point of

-5 CAD aTDC suggests that with asymmetric NVO there is a point where any more

trapped exhaust residual has no effect, and this point is close to the symmetric point.

This can be attributed to the mixing effects when the exhaust residual is pushed into

the intake at earlier asymmetric timings which also causes some cooling.

Both 60 CAD and 80 CAD share similar results both sharing common trends and

similar values of both CA50 and burn duration. At a NVO of 40 CAD, a retarding of
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Figure 4.36: Variation of CA50 and burn duration plotted against the centre of NVO
timing.

CA50 timing and an increase in burn duration is seen when compared to higher values

of NVO duration. The trends change slightly as well. The tests with 40 CAD of NVO

are able to go to much further extreme timings that those of 60 and 80 CAD of NVO.

This suggests that the closer the NVO duration is to 0 CAD, the less volatile and

abnormal the pressure changes are during valve events, allowing the EVVT valves to

operate on a larger range. It also suggests that the residual amount, or temperature,

is less due to a retarding of the CA50 timing.

Figure 4.37 shows the IMEP and BSFC of all three NVO durations. The durations

of 60 and 80 CAD show similar trends again, but slightly different values. As the

duration is expanded to 80 CAD, the BSFC increases and the IMEP decreases. Since

timings for these two are similar (Figure 4.36), this suggests a decrease in volumetric

efficiency, which can be seen in the large decrease in airflow rates between 60 and 80

CAD of NVO. The combustion efficiency seems to drop slightly, but not significantly

as the emissions (Figure 4.40 and 4.41) remain close in value.
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The NVO durations of 60 and 80 CAD show a decrease in IMEP and increase in

BSFC as CA50 in Figure 4.36 advances before 0 CAD aTDC. The other region remains

approximately flat. This confirms that the most fuel efficient location for CA50 is

somewhere after TDC, but the exact maxima of IMEP is not seen due to limited

valve timings available. Again, 40 CAD of NVO duration shows erratic behavior and

a trend could not be discerned.
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Figure 4.37: Variation of load (IMEP) and fuel efficiency (BSFC) plotted against the
centre of NVO timing.

As expected, airflow and lambda follow similar trends in all three durations, shown

in Figure 4.38. The airflow and lambda show a maximum in all three durations around

the SNVO point. This suggests the volumetric efficiency of the valve timings is highest

when the EVC and IVO timings are close to symmetric. This figure also shows that

as NVO duration increases, airflow through the engine decreases. This is expected, as

when NVO duration increases, there is less air expelled and inducted into the engine,

as more time during those strokes the valves are closed.

Exhaust temperature for all three durations shows a local minimum at -5 CAD
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Figure 4.38: Variation of lambda and intake airflow plotted against the centre of NVO
timing.

aTDC, suggesting combustion temperatures are lowest near symmetric NVO timings.

This is shown in Figure 4.39. Local maxima/minima can also be seen in CO and CO2

values in Figure 4.40. Figure 4.41 also shows peaks in both O2 and hydrocarbons

about the symmetric point. Because of the lower temperature, less CO converted

to CO2 and more O2 and hydrocarbons in the exhaust, the results from these three

figures suggest less complete combustion near SNVO timings.

Figure 4.40 show inverse relationships between CO and CO2 for all NVO durations.

This suggests that they are linked to combustion efficiency and completeness of the

combustion.

The O2 and hydrocarbons in the exhaust stream mimic the behaviour of airflow

and lambda for all three NVO durations. In Figures 4.39, 4.40 and 4.41 the 40 CAD

of NVO duration shows a lower exhaust temperature and CO2 emissions and higher

CO, O2 and hydrocarbon emissions. The 60 and 80 CAD of NVO durations both

share similar values and trends in the three figures.

NOx for all valve durations and location timings in this section were found to be
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Figure 4.39: Variation of exhaust temperature plotted against the centre of NVO
timing.
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Figure 4.40: Variation of CO2 and CO emissions plotted against the centre of NVO
timing.
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Figure 4.41: Variation of O2 and hydrocarbon emissions plotted against the centre of
NVO timing.

approximately 19 ppm and within the ±2 ppm experimental error given in Section 3.5.

The values are therefore found to have no relation to the valve timings.

4.8 Trade-Offs within NVO Valve Strategies

In this section the applications and trade-offs of the different valve timing strategies

presented in this study will be discussed. First, using the data from the asymmetric

section, a sensitivity study is conducted. The results are tabulated in Tables 4.1

and 4.2. The units are given in CAD of combustion timing per CAD in NVO change,

whether it be duration or centre of duration timing with respect to TDC. The most

effective areas for control purposes are shown to be NVO duration changes at 40 CAD

of NVO duration in the area of symmetric and late asymmetric centred timings. For

constant duration sensitivity, 80 CAD of duration moved around symmetric TDC

timings and 40 CAD of duration in the late centre timing region show the most

sensitivity to combustion timing.
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Location of NVO aTDC -20 CAD 0 CAD 15 CAD
∆CA50

∆NV ODuration
at 40 CAD -0.03 -0.13 -0.14

∆CA50
∆NV ODuration

at 80 CAD 0.01 -0.01 -0.03

Table 4.1: Sensitivity of combustion timing (CA50) to the duration of NVO at several
different asymmetric timing locations for PRF0.

NVO Duration 40 CAD 60 CAD 80 CAD
∆CA50

∆NV OLocation
at -20 CAD aTDC 0.06 -0.03 0.00

∆CA50
∆NV OLocation

at 0 CAD aTDC -0.03 -0.08 -0.16
∆CA50

∆NV OLocation
at 15 CAD aTDC -0.15 -0.12 0.07

Table 4.2: Sensitivity of combustion timing (CA50) to the asymmetric NVO timing
location at several different NVO durations for PRF0.

A two-stage operating range is shown in the SNVO timing sections. In the range

of SNVO durations between 0 and 100 CAD, we see little change in combustion tim-

ing in the first 40 CAD of change with the PRF0 fuel, but a near linear change in

PRF20 and after 40 CAD for PRF0. The second range begins at 120 CAD where the

timing retards suddenly compared to 100 CAD. The two ranges respond differently

to load changes. Where the first range’s overall slope decreases as the load decreases,

the second range is not affected, allowing the two ranges to cross at a load of approx-

imately 1.5 bar IMEP for both fuels. This dual range behavior can be seen by the

“hump” witnessed in the contour plots of this chapter – this is partially attributed

to unknown intake dynamic oscillations present that can be significant in a single

cylinder engine.

The only major trade-off to the sensitivity of CA50 versus SNVO is the increase

in BSFC as SNVO duration is increased. There is slight changes in load as well,

although not significant. The CO2 emissions increase while the CO and hydrocarbon

emissions decrease. There is an apparent trade-off between combustion efficiency and

load. This study was conducted at low loads and speeds, with low burn durations
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and timings around TDC. If the combustion event occurs prior to TDC, the rapid

compression of the mixture during the burn will cause a more complete combustion

efficiency, while decreasing the load due to the negative work exerted on the piston

crown during its upstroke. If the combustion event occurs slightly after TDC, then

the opposite occurs, with the load increasing due to more work being exerted on the

piston crown during its downstroke, but a less complete combustion efficiency due to

a less rapid pressure and temperature rise.

Asymmetric NVO timings show higher sensitivity in the late-EVC region. The

trade-offs are also similar to that of symmetric timing: An increase in BSFC results

in a slight change in load, an increase in CO2 emissions and a decrease in CO and

hydrocarbon emissions.
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Chapter 5

Timing Control of HCCI1,2

In this chapter, HCCI ignition timing control strategies that are implemented on the

single cylinder engine are described and results presented.

5.1 PI Controller

As a baseline case, a Proportional-Integral (PI) controller is implemented to control

the combustion timing. It is implemented through Simulink on the dSpace Microau-

tobox, with measured input of CA50 signal received from CAS. The controller output

to the engine via valves is the amount of SNVO. The controller is used to track a

CA50 setpoint. The equation implemented for the PI controller is:

uk = uk−1 +Kpek + 0.5KiTs(ek + ek−1) (5.1)

Where uk is the controller output, KP is the proportional gain with a value of 4, KI

is the integral gain with a value of 6, Ts the sampling time which varies with engine

speed, here at N = 800 RPM it is 0.146s, and ek is the error between desired CA50

and measured CA50. The values for the gains are manually tuned in simulation using

1This work is done in conjunction with Khashayar Ebrahimi and is partially based on [Ebrahimi
and Koch, 2013] [Ebrahimi et al., 2014] and [Ebrahimi et al., 2013].

2My contribution is the experimental implementation.
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the detailed physical model [Ebrahimi et al., 2013].

Two setpoint steps are implemented to show the effectiveness of the control. The

first is a step from CA50 at 3 CAD aTDC to -1 CAD aTDC, and the second is

the reverse. The values seen by the dSpace controller (dSpace Microautobox - see

Figure 3.4) are shown in Figures 5.1 and 5.2.
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Figure 5.1: Single cylinder step test of the PI controller at a fuelling rate of 0.4 kJ
per cycle PRF0.

The CA50 has substantial variability which is attributed to combustion timing

variability at these low load operating points. The variability of CA50 is treated as

noise in the controller. The signal tracks the setpoint even though the noise of CA50

is large. Due to the integral action of the PI controller the signal average remains

near the setpoint. The response time is approximately 1.5 seconds for a step down in

setpoint, which correlates to approximately 10 cycles and approximately 0.5 seconds

for a step up, or four cycles. [Agrell et al., 2003a] presents a PI controller as well.



92

0 5 10 15 20
−4

−2

0

2

4

C
A

50
 (

C
A

D
 a

T
D

C
)

 

 

0 5 10 15 20
0

50

100

150

200

Time (s)

N
V

O
 (

C
A

D
)

 

 

CA50 Setpoint
CA50 Actual

Figure 5.2: Single cylinder step test of the PI controller at a fuelling rate of 0.4 kJ
per cycle PRF0.
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Response times for that controller are 1 second, about eight cycles, although during

a load step disturbance, the response time dropped to 5 seconds, approximately 42

cycles. That shows that there is possible room for improved step response speed of

the PI controller.

5.2 Model Based Feed Forward Controller with Integrator

To improve the response time of the control, a feed forward/feedback controller is

developed. The controller uses a look-up table of desired CA50 and current fuelling

rate and gives an appropriate NVO for the setpoint. This table is developed using the

control oriented model described in [Ebrahimi et al., 2013]. An integrator feedback

loop is then added to reject the steady state error. The schematic of this controller

can be seen in Figure 5.3. The value of the integral gain is set to 3, and the sampling

time remains at 0.146 seconds.

Figure 5.3: Schematic of the model based feed forward with integrator controller.

This controller is then put through some step tests. The results of these tests can

be see in Figure 5.4.

The feed forward part of this controller provides a much better response time

when compared to the PI controller. The rise time for the feed forward controller is
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Figure 5.4: Single cylinder step test of the model based feed forward with integrator
controller at a fuelling rate of 0.4 kJ per cycle PRF0.
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on average approximately four cycles. This is compared to an average of seven cycles

for the PI controller. This shows a decrease of over 40% in rise time. The CA50

reference step input applied to the feed forward controller is also one CAD larger

than that of the PI controller. [Lundstrom, 2006] developed a controller using black-

box modelling and pole-placement/loop-shaping, and resulted in a rise time of 5-7

cycles. The setup time for that controller is also significantly larger. [Bengtsson et al.,

2006] uses physical modelling similar to this study, and developed a controller using

loop-shaping, which also resulted in a larger rise time of approximately 12 cycles.

The controller presented here therefore shows improvement over these controllers,

although only for a limited load range. A wider load range can be implemented using

feed forward tables which can be pre-calculated using the control oriented model

described in [Ebrahimi et al., 2013].

5.3 Empirically Based Feed Forward Controller with Integrator

The feed forward controller discussed above uses a table calculated through the use

of the control oriented model. In an attempt to develop more accurate data, the

table is tuned using the experimental data. The data collected is at steady state, and

the CA50 versus fuelling rate table is created using cubic interpolation to find SNVO

durations at appropriate CA50 values. The control structure and implementation is

exactly the same as above, only the table values are now based on experiment. The

controller is put through the same step tests as above, and compared to the feed

forward controller based on the engine model.

Figure 5.5 shows a rise-time for the empirical table on average of approximately

six cycles. This is slower than the model-based controller, which shows a rise time of

just four cycles on average. This shows that the model-based lookup table takes into

consideration transients, where as the empirically-based table relies on steady-state
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Figure 5.5: Single cylinder step test of the empirically based feed forward with inte-
grator controller at a fuelling rate of 0.4 kJ per cycle PRF0.
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tests to find NVO durations. This experimental table is also time consuming to fill

with values as every point must be run on the engine.
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Chapter 6

Conclusions

Conclusions and future work are described in this chapter.

6.1 Conclusions

The goal of this study is to investigate the effects of various valve timing strategies on

HCCI combustion characteristics. A single cylinder engine is run through different

operating points using state-of-the-art EVVT to apply cycle-by-cycle independent

valve timings. The main valve timings changed are EVC and IVO, which are set to

negative valve overlap, or NVO. This allows internal residual to be trapped within

the cylinder which causes more heat to be retained in the mixture of the next cycle,

as well as dilution, chemical and thermal effects.

The first strategy investigated is symmetric NVO, denoted SNVO, where both

EVC and IVO are varied symmetrically about TDC of the gas exchange. This strategy

showed a range of effects, including timing, load, efficiency and emissions. This

strategy is acceptable for use in controlling combustion timing in HCCI operation.

The engine had different responses to the symmetric strategy for low compared to

high SNVO durations. The overall effects of increasing symmetric NVO duration are:

• An advance in combustion timing, as well as shorter burn duration.



99

• Since the engine is operated lean, a decrease in lambda and an increase load.

• An increase in BSFC.

• An increase in exhaust temperature.

• A decrease in fresh air intake.

• An increase in CO2 emissions and a decrease in O2, CO and hydrocarbon emis-

sions.

The effects of PRF is also investigated in conjunction with SNVO. While a higher

PRF produced a later combustion timing, longer burn and higher load, the region

between misfire and knock is narrower.

Another strategy investigated is that of asymmetric NVO timings, where EVC

and IVO are held a certain duration apart, then that duration is moved with respect

to TDC of the gas exchange. This strategy showed more varied effects over the range

of NVOs investigated, although in some ranges this strategy showed high sensitivity

to combustion timing.

Using the knowledge gained from the valve timing investigations, controllers to

control combustion timing in HCCI operation are implemented on the single cylinder

engine. Initially a PI controller using the EVVT valves is found to perform similar

to other VVT applications in the literature. Then a feed forward with integral action

controller is implemented using a look up table parameterized by the model presented

in [Ebrahimi et al., 2013]. This controller had excellent transient response to set point

changes in CA50 and could reach the setpoint within four cycles.

6.2 Future Work

• A more in-depth investigation into the effects of asymmetric NVO is suggested,

using a wider range of timings as well as different PRF fuels. This would allow
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the effects of the timings to be better understood, and the varied behavior of

the timings investigated.

• Use of different fuels such as bio-fuels could be investigated using the same valve

strategies and compared to the results of the primary reference fuels.

• More complex controllers that can handle a wider array of operating conditions

while also taking into account the numerous constraints of the valves and range

of engine operation between misfire and knock.

• Focus on higher extending the HCCI operating conditions into higher loads and

engine speeds by maintaining CA50 timing after TDC.

• A dynamic analysis of the residual fraction so an accurate value for residual can

be calculated during transients.
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Appendix A

Engine Procedures

A.1 Engine Operating Procedure

For engine operation, follow these steps:

1. Turn on all devices, including:

• Transducer pump

• Valve controllers (2)

• Valve power supplies (2)

• CO canary and Lambda sensor

• Power bar and three power supplies

• Microautobox and CAS system

• MTS board

• Air and water

• Fuel pumps and release tank screws

2. Turn on all four computers needed, including:

• Valve computers (2)
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• ADAPT/dSapce computer

• CAS Computer

3. Run ADAPT on the ADAPT/dSpace computer desktop, click ‘Yes’. Under

‘Control’ menu, click select test and select ‘phaser sep28.tst’. Errors should

occur in the error window, this is fine.

4. Under ‘Control’ menu, click start test, increment the test number by one, click

‘OK’.

5. Click ‘Manual’, then ‘Reset Safety String’. Wait for the indicators to go green

and the fans turn on, then click ‘Start Dyno Drive’.

6. Set desired RPM, coolant temp, oil temp, air temp and throttle position. Do

not forget to turn on the temp controllers.

7. On the valve computers (procedure is the same for both) go to ‘D:\mm\dspace’,

right click on ‘fluxrev6’ and click command prompt here.

8. Type ‘down1103 fr.mk’ and hit enter.

9. When the build process is complete open Control Desk from the desktop. Click

‘File>Open Experiment’. Open ‘ValveControlv3a.cdx’. Once open, click the

‘Parameter’ tab on the bottom and drag the divider bar up. right click on

‘bk1 hand flt4’ and click ‘Declare status set’. Click ‘Parameter Editor>Write’

all parameters now. Then click the ‘Run’ mode.

10. On the intake valve, increase the brake current to 9.

11. On the exhaust valve, increase the opener current to 5.5, the closer current to

4.7 and set the brake velocity to 3.5.
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12. Turn on power on both valves. Click ‘Fail’ then ‘Swing’ until the valve shuts,

then click the RPM box. Repeat for both valves

13. Once the valves are running with the engine motoring, run CAS on the CAS

computer desktop. Connect to the CAS computer, and click the green flag to

start the pressure trace.

14. Open Control Desk on the ADAPT/dSpace computer desktop. ‘File>Open

Experiment’ and select the experiment you wish to run. Click the ‘Run’ mode

and press F11 for fullscreen.

15. Once ready for fuel, turn on the emergency switch on the desk. If the valves

fail during the test, immediately turn this switch off to stop the fuel injection.

To take data in dSpace, make sure you drag any parameters from the bottom of

the screen into the data log box (a good starting set is to drag all the values under

‘Labels’). Once the engine is running, make sure the data log is on cycle-based, and

click ‘Take’. Once it is completed, click ‘Save’ and save where you want the data. For

ADAPT, click ‘Data>Save Data’, once completed click ‘Report>Data Report’ and

click ‘Save’ and save where you want the data, then click ‘Done’. For CAS, make

sure you setup the data save under ‘Data>Save Data Setup’, then click ‘Data>Save

Data’.

The shut down is essentially the reverse of the power up phase of this procedure.

Hit ‘Stop’ on the ADAPT screen, then ‘Control>Stop Test’ and close adapt. Click

‘Animation Mode’ on all three Control Desk Applications (dSpace and the two valves)

and click the stop button, then close the Control Desks. Click the red flag in CAS

then close CAS. Then turn off everything from step 1.
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A.2 dSpace Controller Design Procedure

When a new Simulink model is desired, open MATLAB on the ADAPT/dSpace com-

puter desktop. When loaded, type ‘tdc=230;’ and hit enter. Make sure the MATLAB

workspace is set to ‘C:\MATLAB R2007a\work\Fall2009’. Open the desired model

to be modified. Click ‘Save As’ and rename if it is becoming a new model. Once the

re-designs are completed, press ‘Ctrl+B’ to build the model.

If a new Control Desk experiment is required, copy a whole file over from a similar

experiment and open it. In the parameter window at the bottom, right click on the

.sdf and click ‘replace .sdf’. Choose your newly built .sdf from the MATLAB folder.

Remove the old .sdf from the experiment, add in the new one and refresh implicit

files (off a right click in the experiment browser). Save as a new experiment, close

and reopen. Then load the new .sdf onto the MicroAutobox. Be sure to load any

parameters into the Data Log box before starting the experiment.

A.3 Emissions Bench Procedure

To take emissions data, follow the same procedure as engine operation, but turn on

the emissions bench by turning on the sample pump and the four switches on the

emissions bench. Be sure the H2 and N2 bottles are also open. Once the bench is on,

click the ‘Flame’ button on the hydrocarbon analyzer. On the emissions screen of the

ADAPT interface, click the ‘downstream’ button. The emissions bench is now ready

for experiments.

For calibration, go to the emissions bench screen in on the ADAPT interface.

Make sure all the gas bottle are open. To zero out all the analyzers, click the ‘zero

calib’ button and wait until the the analyzers settle, then hit the ‘zero’ buttons on the

analyzers, or under the calibration menu (password is 111) hit the zero calibration.

Then repeat for each analyzer using the span instead of zero. Make sure the span is
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set to the same as the concentration on the bottle.
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Appendix B

Experimental Data
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Date Collected Number of Test Points Description

July 19, 2012 9 Model Validation
August 28, 2012 5 Model Validation

September 8, 2012 11 Model Validation
September 25, 2012 8 Model Validation

October 2, 2012 20 Model Validation
October 5, 2012 10 Model Validation

November 8, 2012 8 Model Validation
December 21, 2012 6 Model Validation
January 23, 2013 6 Model Validation
January 29, 2013 148 Mapping
February 7, 2013 3 Model Validation
February 15, 2013 3 Model Validation

May 6, 2013 1 Frequency Analysis
May 7, 2013 1 Frequency Analysis
May 8, 2013 2 Frequency Analysis
May 9, 2013 1 Frequency Analysis
May 16, 2013 30 Frequency Analysis
June 11, 2013 1 PI
June 13, 2013 1 PI

August 20, 2013 17 Controller
August 22, 2013 55 Mapping

September 3, 2013 9 Controller
October 24, 2013 4 Model Controller and Repeatability

December 11, 2013 7 RBS and Repeatability
December 17, 2013 6 RBS and Repeatability
January 16, 2014 1 RBS
January 20, 2014 5 Asymmetric Mapping
January 29, 2014 9 Asymmetric Mapping
February 6, 2014 24 Observer Test and Asymmetric Mapping
February 13, 2014 3 MPC Test
February 17, 2014 1 MPC Test

March 13, 2014 4 Observer, PI and MPC Test
March 17, 2014 2 Feedforward Test
April 10, 2014 2 Fuel RBS
May 1, 2014 2 NVO Model Input
May 5, 2014 6 PRBS

Table B.1: Experimental Data Summary
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File Name Description

adapt.m Code for extracting values from imported
Adapt data

adaptcsvchange.m Code for modifying Adapt csvs for use in Mat-
lab

DATAMASTER.m and variations thereof Code for extracting and calculating needed data
from mapping experiments

derivativeP.m Code for calculating multiple derivatives of the
pressure trace

Dspace Data.m Code for extracting values from imported
dSpace data

ERRORCALC.m Code for calculating sample error from one test
point

FFTsystem.m Frequency analysis code
HRfcn.m Code called by other codes when heat transfer

analysis data was needed
Interpolation.m Code used to line up input and output data’s

sampling times by interpolation
knockcharateristics.m Code used to looked at different knock charac-

teristics
LINEARIZINGFORMULA.m Code used when looking at different linearizing

options
linecount.pl Python code called in adaptcsvchange.m to

count lines in a csv
loadgraph.m Plotting code

MA.m A discrete filter type code
max1.m Code called in DATA.m codes
min1.m Code called in DATA.m codes

plotcontour.m Plotting code
plotIVC.m Plotting code
plotNVO.m Plotting code

plots.m Plotting code
plotyyy.m Downloaded code for plotting on 3 y-axes

spectrumsys.m Frequency analysis code
spectrumXY.m Frequency analysis code

subplots.m Plotting code
subplotyu.m Plotting code

THESIS cas2mat converter.m Code to convert CAS files to Matlab files
timestep.m Code to calculate the timestep in data

tIVC.m Sampling time adjustment code
tNVO.m Sampling time adjustment code

truncate.m Code use to truncate data

Table B.2: Computer Program Summary
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Agrell, F., Ångström, H.-E., Eriksson, B., Wikander, J., and Linderyd, J. (2003a).

Integrated simulation and engine test of closed loop HCCI control by aid of variable

valve timings. In SAE Paper 2003-01-0748.
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